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1.0 About the SDR+ XML Format 
This document is intended as a reference for the SDR+ XML format. This format is used in the XML 
report produced by the SDR+ Export module, and was designed as a standard format for the output of 
SDR+ job information. 

Note: For details about the SDR+ Export module, or about using this XML format with XSL transformation 
(XSLT) templates, refer to the SDR+ User Guide. For technical information about using XSLT when 
working with XML file formats, refer to http://www.w3.org/TR/xslt. For general technical information 
about XML, refer to http://www.w3.org/XML. 

Currently, SDR+ uses XSLT version 1.1. All XSLT conversion files must conform to this version to work 
with SDR+. 

1.1 Overview 
The general structure of the XML report is as follows: 

<?xml version="1.0" encoding="UTF-8" standalone="yes" ?> 

<JOB>… 

 <Job properties>  </Job properties> 

 <First record>  </First record> 

 …//time-ordered 

 <Last record>  </Last record> 

</JOB> 

Job properties (see Section 2.0) are located at the beginning of the XML report. 

The order of job data records is time-ordered. The first entry in the XML report corresponds to the 
earliest record in the job, and the last entry corresponds to the most current record in the job. See 
Section 3.0 for details about job data records. 

1.2 Unit Formats 
The following unit formats are always used in the SDR+ XML format, unless otherwise specified in this 
document: 

• All linear values are output in meters. 

• All angular values are output in decimal degrees. 

1.3 Field Formats 
The following field formats are used to describe the type of data presented in each field. 

 

Format Description 

INT Integer value 

BOOL Boolean value (true/false) 

STRING String 

ENUM Enumerated value 

FLOAT Floating point value. If a value is not available or not computable, “NotComputable” is written in 
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the field. 

UID Unique Identifier. This ID is unique within the job, but not across multiple jobs. 

GUID Globally Unique Identifier 

TIMESTAMP Time (see Section 1.3.1). 

COORD Coordinates (see Section 1.3.2). 

CARTCOORDTYPE Cartesian coordinates (see Section 1.3.3) 

1.3.1 TIMESTAMP 

All timestamps are with respect to the system time set on the data controller at the time the record was 
created or was last modified. In this document, records that include a time subsection refer to it as the 
field “Time” of the format TIMESTAMP. 

All timestamps have the following form: 
<Time> 

 <Year>2007</Year> 

 <Month>5</Month> 

 <Day>2</Day> 

 <DayOfWeek>3</DayOfWeek> 

 <Hour>10</Hour> 

 <Min>36</Min> 

 <Sec>45</Sec> 

 <ms>789</ms> 

</Time> 

 

Field Description Format Options 

<Year> Year INT  

<Month> Month ENUM January = 1, February = 2, …,  
December = 12 

<Day> Day of the month INT  

<DayOfWeek> Day of the week ENUM Sunday = 0, Monday = 1, …, Saturday = 6 

<Hour> Hour the job was created INT  

<Min> Minute the job was created INT  

<Sec> Second the job was created INT  

<ms> Millisecond the job was created INT  

1.3.2 COORD 

All point coordinates are presented using the COORD field type. The COORD format has the following 
form: 

<Coord> 

 <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID>  

 <C1>123.321</C1> 

 <C2>123.321</C2> 
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 <C3>123.321</C3> 

</Coord> 

All coordinates are written with respect to an associated coordinate system record (in the 
<CoordSystemGUID> field). 

All coordinate values are written in meters and decimal degrees. 

Height values are exported as follows: 

• For Geographic systems, Height values are exported as orthometric if the associated coordinate 
system has a geoid applied; otherwise, they are ellipsoidal. 

• For Projected systems, Height values are exported as orthometric if the associated coordinate 
system has a geoid applied; otherwise, they are grid heights. 

• For Local grid systems, all Height values are exported as grid heights. 

Projected and Local grid systems assume positive N/Y axes in the up direction and E/X axes in the right 
direction (a right handed system). 

Coordinate field values displayed in the C1, C2, and C3 fields are dependent on the associated coordinate 
system frame: 

• Frame is LLH (Geographic). C1, C2, and C3 correspond to Latitude, Longitude, Height. 
<Coord> 

 <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID> 

 <C1>51.32101254</C1> // This value is Latitude in decimal degrees 

 <C2>-114.123321</C2> // This value is Longitude in decimal degrees 

 <C3>1024.201</C3>  // This value is Height in meters 

</Coord> 

• Frame is NEH (Projected). C1, C2, and C3 correspond to Northing, Easting, Height. 
<Coord> 

 <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID>  

 <C1>5666939.125</C1> // This value is Northing in meters 

 <C2>707280.985</C2> // This value is Easting in meters 

 <C3>1024.201</C3>  // This value is Height in meters 

</Coord> 

• Frame is XYH (Local Grid). C1, C2, and C3 correspond to Y, X, Height. 
<Coord> 

 <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID>  

 <C1>1000.000</C1> // This value is Y in meters 

 <C2>5000.000</C2> // This value is X in meters 

 <C3>10.00</C3>  // This value is Height in meters 

</Coord> 

• If the coordinates are not computable, “NotComputable” is written to the field. 
<Coord> 

 <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID>  

 <C1>NotComputable</C1> 

 <C2>NotComputable</C2> 

 <C3>NotComputable</C3> 

</Coord> 
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1.3.3 CARTCOORD Type 

ECEF Cartesian point coordinates will be included in the XML report using the CARTCOORD field 
type.  

The ECEF Cartesian coordinates will be calculated using the current job coordinate system datum 
and ellipsoid.   

The ECEF Cartesian coordinates will be calculated from ellipsoidal heights.  

If the Frame is XYZ (the ECEF Cartesian Export option was selected): C1, C2, and C3 will 
correspond to X, Y, Z. 

The ECEF Cartesian coordinate values will be in meters.  

The CARTCOORD format will have the following form: 

<CartesianCoords>   

   <X>123.321</X> 

   <Y>123.321</Y> 

   <Z>123.321</Z> 

</CartesianCoords> 

 

If the Cartesian coordinates are not computable, NotComputable will be written in the X, Y, and Z 
fields. 

2.0 Job Properties 
Job properties are always included in the XML report, regardless of the job data content. Job properties 
include the following information: 

 

Job Property Section String 

Job Name JobName 

Job Timestamp Time 

Versions Versions 

Job Properties JobProperties 

Job Settings JobSettings 

Coordinate System CoordinateSystem 

2.1 Job Name 
The job name section contains the name of the job: 

<JobName>Job01</JobName> 

2.2 Job Timestamp 
The job timestamp section contains the job’s last modified date and time. It follows the format for 
timestamps described in Section 1.3.1. 

 Page 7 of 48 



SDR+ XML Format Reference Guide 
 
 
2.3 Versions 
The versions section contains the SDR+ version and the XML Export Format version: 

<Versions> 

 <XMLExport>2.0</XMLExport> 1 

 <SDRPlus>7.3.1.17990</SDRPlus> 

</Versions> 

 

Field Comments Format 

<XMLExport> Format of V.R, where V is the version number and R is the revision number. STRING 

<SDRPlus> Format of V.V.V.RRRRR, where V.V.V is the SDR+ version number and 
RRRRR is the SDR+ build number. 

STRING 

 
2.4 Job Properties 
The job properties section contains all the properties of the job: 

<JobProperties> 

 <Project>Ring Road Job</Project> 

 <Location>Calgary N.W.</Location> 

 <Surveyor>B. Jones</Surveyor> 

 <SurveyorCompany>Bob’s Surveys</SurveyorCompany> 

 <Client>City of Calgary</Client> 

 <ClientCompany>Calgary City Council</ClientCompany>  

 <Comments>Secondary survey of the new Ring Road addition to Sarcee Trail</Comments> 

</JobProperties> 

 

Field Format 

<Project> STRING 

<Location> STRING 

<Surveyor> STRING 

<SurveyorCompany> STRING 

<Client> STRING 

<ClientCompany> STRING 

<Comments> STRING 

2.5 Job Settings 
The job settings section contains the job’s settings information: 

<JobSettings> 

 <BacksightWeighting>Uniform</BacksightWeighting> 

 <EarthRadius>63190000</EarthRadius> 

                                                           
1 As of SDR+ version 9.2.1., the current SDR+ XML Format Version is 2.0. 
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 <ScaleFactor>1.000</ScaleFactor> 

 <ApplyAtmosphericCorrection>true</ApplyAtmosphericCorrection> 

 <ApplyCurvatureAndRefractionCorrection>true</ApplyCurvatureAndRefractionCorrection> 

 <RefractiveIndex>0.14</RefractiveIndex> 

 <ApplySeaLevelCorrection>true</ApplySeaLevelCorrection> 

 <VerticalAngleReference>Zenith<VerticalAngleReference> 

 <LinearUnit>Meters</LinearUnit>  

 <LinearPrecision>4</LinearPrecision>  

 <AngularUnit>DMS</AngularUnit>  

 <AngularPrecision>5</AngularPrecision>  

 <TemperatureUnit>Celsius</TemperatureUnit> 

 <PressureUnit>mmMercury</PressureUnit> 

 <GradeUnit>Percent</GradeUnit> 

 <SideSlopeUnit>Ratio</SideSlopeUnit> 

 <AreaUnit>SquareMeters</AreaUnit> 

 <AreaPrecision>4</AreaPrecision> 

 <VolumeUnit>CubicMeters</VolumeUnit> 

 <VolumePrecision>4</VolumePrecision> 

 <ScalarUnit>Scalar</ScalarUnit> 

 <ScalarPrecision>9</ScalarPrecision> 

</JobSettings> 

 

Field Comments Format Options 

<BacksightWeighting>  STRING ByDistance 

Uniform 

<EarthRadius> Units are meters. FLOAT  

<ScaleFactor> Value is always scalar. FLOAT  

<ApplyAtmosphericCorrection>  BOOL  

<ApplyCurvatureAndRefraction 
Correction> 

 BOOL  

<RefractiveIndex> Only included if 
ApplyCurvatureAndRefractionCorrection 
field is set to true. 

Unitless value. 

FLOAT  

<ApplySeaLevelCorrection>  BOOL  

<VerticalAngleReference> From Application settings. STRING Horizon 

Zenith 
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Field Comments Format Options 

<LinearUnit> From Application settings. STRING Meters 

Feet 

USFeet 

Yards 

Inches 

<LinearPrecision> From Application settings. INT  

<AngularUnit> From Application settings. STRING DMS 

DM 

Degrees 

Gons 

Mils 

Radians 

HP 

<AngularPrecision> From Application settings. INT  

<TemperatureUnit> From Application settings. STRING Celsius 

Fahrenheit 

<PressureUnit> From Application settings. STRING MmMercury 

InchesMercury 

Millibars 

Psi 

Pascals 

<GradeUnit> From Application settings. STRING Percent 

Ratio 

<SideSlopeUnit> From Application settings. STRING Percent 

Ratio 

<AreaUnit> From Application settings. STRING SquareMeters 

SquareYards 

SquareFeet 

SquareUSFeet 

SquareMiles 

Hectares 

Acres 

<AreaPrecision> From Application settings. INT  
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Field Comments Format Options 

<VolumeUnit> From Application settings. STRING CubicMeters 

CubicYards 

CubicFeet 

CubicUSFeet 

<VolumePrecision> From Application settings. INT  

<ScalarUnit> From Application settings. STRING Scalar 

ppm 

<ScalarPrecision> From Application settings. INT  

2.6 Coordinate System 
The coordinate system section contains the job’s coordinate system information: 

<CoordinateSystem> 

 <IsJobSystem>true</IsJobSystem> 

 <GUID>6A2047E0-CA04-01C2-8601-93D145058B2E</GUID> 

 <Name>UTM Zone 11 (N)</Name> 

 <Description>UTM Zone 11 (N) on NAD83</Description> 

 <IsGeoidApplied>false</IsGeoidApplied> 

 <Frame>NEH</Frame> 

 <LinearUnit>meters</LinearUnit> 

 <LinearHorizontalPrecision>3</LinearHorizontalPrecision> 

 <LinearVerticalPrecision>3</LinearVerticalPrecision> 

 <AngularUnit>DMS</AngularUnit> 

 <AngularPrecision>5</AngularPrecision> 

</CoordinateSystem> 

 

Field Format Options 

<IsJobSystem> BOOL  

<GUID> GUID MAXLENGTH = 36 

<Name> STRING MAXLENGTH = 32 

<Description> STRING MAXLENGTH = 64 

<IsGeoidApplied> BOOL  

<Frame> STRING XYH (Local grid)  

NEH (Projected System)  

LLH (Geographic System) 
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Field Format Options 

<LinearUnit> STRING Meters 

Feet 

USfeet 

Yards 

<LinearHorizontalPrecision> INT  

<LinearVerticalPrecision> INT  

<AngularUnit> STRING DMS  

DM 

Degrees 

HP 

<AngularPrecision> INT  

3.0 Job Data Records  
All job data records are contained in separate sections. The available record types include the following: 

 

Job Record Type Section String 

Job Point Point 

KI Point KICoordinate 

KI Azimuth KIAzimuth 

KI Line Line 

KI Arc Arc 

KI Spiral Spiral 

Polygon Polygon 

Polyline Polyline 

COGO Radiation COGORadiation 

COGO Inverse COGOInverse 

Instrument Instrument 

Station Station 

Target Target 

ETS Observation ETSObservation 

Resection Station ResectionStation 

Resection Observation ResectionObservation 

RTK Session RTKSession 

GPS Antenna GPSAntenna 
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Job Record Type Section String 

RTK Observation RTKObservation 

Meteorological Meteorological 

Note Note 

Traverse Traverse 

3.1 Point 
<Point> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ID>1001</ID> 

 <FeatureCode>Corner</FeatureCode> 

 <Computable>3D</Computable> 

 <Coord> 

  <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID> 

  <C1>5666939.721</C1> 

  <C2>707280.216</C2> 

  <C3>1045.154</C3> 

 </Coord> 

 <CartesianCoord> 

  <X>5666939.721</X> 

  <Y>707280.216</Y> 

  <Z>1045.154</Z> 

 </CartesianCoord> 

 <HorizontalDerivation>ETSObservation</HorizontalDerivation> 

 <VerticalDerivation>ETSObservation</VerticalDerivation> 

 <IsStaked>false</IsStaked> 

 <StakedDesign> 

  <DesignEntityUID>235795224</DesignEntityUID> 

  <VerticalReference>JobData</VerticalReference> 

  <AlongLine>2.04</AlongLine> 

  <HorizontalOffset>1.000</HorizontalOffset> 

  <VerticalOffset>0.0000</VerticalOffset> 

  <PolyLineStakedType>Back</PolyLineStakedType> 

  <SlopeType>RightCut</SlopeType> 

  <Slope>2.000</Slope> 
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 </StakedDesign> 

 <CutFill> 

  <DeltaX>0.012</DeltaX> 

  <DeltaY>1.023</DeltaY> 

  <DeltaH>1.023</DeltaH> 

  <DeltaHorizontal>1.023</DeltaHorizontal> 

  <Delta3D>1.023</Delta3D> 

  <DeltaAlongLine>1.023</DeltaAlongLine> 

  <DeltaOffline>1.023</DeltaOffline> 

  <CenterCutFill>1.023</CenterCutFill> 

 </CutFill> 

</Point> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<Computable>  STRING Vert 

Horz 

3D 

Not 

<Coord> See Section 1.3.2 for more information. 

Units are decimal degrees and meters. 

Frame is frame from CoordinateSystem 
record. 

COORD  

<CartesianCoord> See Section 1.3.3 

Units will be meters.   

Frame will be XYZ and Cartesian coordinates 
will be computed based on the current 
coordinate system datum and ellipsoid. 

If coordinates cannot be computed, 
NotComputable is written in place of values. 

CARTCOORD  
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Field Comments Format Options 

<HorizontalDerivation> See Section 3.1.1 for information about 
derivation types. 

STRING ETSObservation 

RTKObservation 

MultiRTK 

MultiETS 

MultiRTKSetups 

MultiETSSetups 

Multisource 

KeyboardInput 

Resection 

COGORadiation 

NotCoordinated 

<VerticalDerivation> See Section 3.1.1 for information about 
derivation types. 

STRING ETSObservation 

RTKObservation 

MultiRTK 

MultiETS 

MultiRTKSetups 

MultiETSSetups 

Multisource 

KeyboardInput 

Resection 

COGORadiation 

NotCoordinated 

<IsStaked>  BOOL  

<StakedDesign> -- SUB-SECTION HEADER -- 

StakedDesign section is included only if 
IsStaked value is true (a staked value has 
been recorded). 

  

<DesignEntityUID> Included only if staking job data (not 
included for surface staking). 

UID  

<VerticalReference>  STRING DTM + <Offset> 

<FixedElevation> 

JobData 

<AlongLine> Included only if staking Line, Arc, or Polyline 
(not included for surface staking or point 
staking). 

Units are meters. 

FLOAT  
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Field Comments Format Options 

<HorizontalOffset> Included only if staking Line, Arc, or Polyline 
(not included for surface staking or point 
staking). 

Units are meters. 

FLOAT  

<VerticalOffset> Included only if staking Line, Arc, or Polyline 
(not included for surface staking or point 
staking). 

Units are meters. 

FLOAT  

<PolyLineStakedType> Included only if the design entity is a 
polyline. 

STRING Back 

Bisect 

Ahead 

Normal (not staking 
an intersection) 

<SlopeType> Included only if staking Line, Arc, or Polyline 
(not included for surface staking or point 
staking). 

STRING None 

RightCut 

RightFill 

LeftCut 

LeftFill 

<Slope> Included only if SlopeType is NOT None. 

Percentage. 

FLOAT  

<CutFill> -- SUB-SECTION HEADER -- 

Included only if IsStaked value is true. 

  

<DeltaX> Included only when staking job data (not 
included for surface or slope staking). 

Units are meters. 

FLOAT  

<DeltaY> Included only when staking job data (not 
included for surface or slope staking). 

Units are meters. 

FLOAT  

<DeltaH> If staking slopes, this value is the Slope Delta 
Height. 

Units are meters. 

FLOAT  

<DeltaHorizontal> Included only if point was staked from a line, 
arc, or polyline and not slope staked. 

Units are meters. 

FLOAT  

<Delta3D> Included only if point was staked from a line, 
arc, or polyline and not slope staked. 

Units are meters. 

FLOAT  
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Field Comments Format Options 

<DeltaAlongLine> Included only if the point was staked from a 
line, arc, or polyline and an interval was 
defined. 

Units are meters. 

FLOAT  

<DeltaOffline> Included only if the point was staked from a 
line, arc, or polyline. Always positive for slope 
staked data. 

Units are meters. 

FLOAT  

<CenterCutFill> Included only if SlopeType is NOT None. 

Units are meters. 

FLOAT  

3.1.1 Derivation Types 

Type Description 

RTKObservation One RTK observation coordinates the point 

ETSObservation One ETS observation coordinates the point 

MultiRTK More than one RTK observation from the same session coordinates the point 

MultiETS More than one ETS observation from the same station coordinates the point 

MultiRTKSetups RTK observations from different sessions coordinate the point 

MultiETSSetups ETS observations from different stations coordinate the point 

Multisource Both RTK and ETS observations coordinate the point 

KeyboardInput Derivation was keyed in, imported, created during Static/Kinematic survey, auto-
generated by COGO tape from baseline, COGO point projection, COGO points from 
polyline, COGO intersection, or auto-generated when defining an Arc or Spiral. 

Resection Resection derived 

COGORadiation COGO radiation derived 

NotCoordinated No derivation method 

3.2 KI Coordinate 
<KICoordinate> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 
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 </Time> 

 <DerivationType>UserInput</DerivationType> 

 <Coord> 

  <CoordSystemGUID>6A2047E0-CA04-01C2-0B02-18D2CA05102F</CoordSystemGUID> 

  <C1>51.23231254</C1> 

  <C2>-114.05231254</C2> 

  <C3>1045.315</C3> 

 </Coord> 

 <PointUID>874653217</PointUID> 

 <IsControl>True</IsControl></KICoordinate> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<DerivationType>  STRING UserInput 

StaticKinematic 

Intersection 

PointProjection 

Endpoint 

Import 

TapeFromBaseLine 

PointsFromPolyline 

TraverseAdjustment 

Arc 

Spiral 

<Coord> See Section 1.3.2 for more information. 

Units are decimal degrees and meters. 

Coordinate system frame follows the frame in the 
associated CoordSystemGUID record. 

COORD  

<PointUID>  UID  

<IsControl>  BOOL  
 

3.3 KI Azimuth 
<KIAzimuth> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 
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  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <FromPointUID>915154734</FromPointUID> 

 <ToPointUID>514746015</ToPointUID> 

 <Azimuth>110.1541587</Azimuth> 

</KIAzimuth> 

 

Field Comments Format 

<UID>  UID 

<Time> See Section 1.3.1 for more information. TIMESTAMP 

<FromPointUID>  UID 

<ToPointUID>  UID 

<Azimuth> Units are decimal degrees. FLOAT 

3.4 Line 
<Line> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ID>1001</ID> 

 <FeatureCode>Some feature code</FeatureCode> 

 <FromPointUID>898093495</FromPointUID> 

 <ToPointUID>953202353</ToPointUID> 

 <Azimuth>120.0154678</Azimuth> 

 <DeltaHeight>1.0101</DeltaHeight> 

 <Length2D >1.041</Length2D > 

 <Length3D >2.041</Length3D > 

</Line> 
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Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<FromPointUID>  UID  

<ToPointUID>  UID  

<Azimuth> Units are decimal degrees. FLOAT  

<DeltaHeight> Units are meters. FLOAT  

<Length2D > Units are meters. FLOAT  

<Length3D > Units are meters. FLOAT  

3.5 Arc 
<Arc> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ID>1001</ID> 

 <FeatureCode>Arc feature code</FeatureCode> 

 <FromPointUID>324993322</FromPointUID> 

 <ToPointUID>934923490</ToPointUID> 

 <Direction>Left</Direction> 

 <Radius>2.04</Radius> 

 <ArcLength>2.04</ArcLength> 

 <ChordLength>2.04</ChordLength> 

 <DegreeOfCurve>15.00000</DegreeOfCurve> 

 <Delta>2.00000</Delta> 

 <TangentAzimuth>2.04</TangentAzimuth> 

 TangentDistance>2.04</TangentDistance> 

 <DeltaHeight>2.04</DeltaHeight> 

</Arc> 
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Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<FromPointUID>  UID  

<ToPointUID>  UID  

<Direction>  STRING Left 

Right 

<Radius> Units are meters. FLOAT  

<ArcLength> Units are meters. FLOAT  

<ChordLength> Units are meters. FLOAT  

<DegreeOfCurve> Units are decimal degrees. FLOAT  

<Delta> Units are decimal degrees. FLOAT  

<TangentAzimuth> Units are decimal degrees.   

<TangentDistance> Included only if computable. 

Units are meters. 

FLOAT  

<DeltaHeight> Units are meters. FLOAT  

3.6 Spiral 
<Spiral> 

 <UID>1174405121</UID>  

 <Time> 

  <Year>2008</Year>  

  <Month>11</Month>  

  <Day>7</Day>  

  <DayOfWeek>5</DayOfWeek>  

  <Hour>14</Hour>  

  <Min>9</Min>  

  <Sec>43</Sec>  

  <ms>270</ms>  

 </Time> 

 <ID>TSSCSpiral_Sprl</ID>  

 <FeatureCode>Modified FC</FeatureCode>  

 <FromPointUID>100663298</FromPointUID>  

 <ToPointUID>100663299</ToPointUID>  

 <SpiralType>CSToSC</SpiralType>  

 <Direction>Left</Direction>  

 <RadiusIn>100.0</RadiusIn> 

 <RadiusOut>100.0</RadiusOut> 
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 <DegreeOfCurveIn>100.0</DegreeOfCurveIn> 

 <DegreeOfCurveOut>100.0</DegreeOfCurveOut> 

 <CentralAngle>100.0</CentralAngle>  

 <TangentAzimuth>100.0</TangentAzimuth>  

 <A>100.0</A> 

 <CStoSCLength>102.673072406242</CStoSCLength> 

 <TStoSCLength>102.673072406242</TStoSCLength> 

 <SpiralLength>102.673072406242</SpiralLength> 

 <DeltaHeight>102.673072406242</DeltaHeight>  

</Spiral> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<FromPointUID>  UID  

<ToPointUID>  UID  

<SpiralType> 
 STRING TSToSC 

SCToST 
CSToSC 
ReverseCSToSC (used 
when long radius is 
the radius out) 

<Direction>   STRING Left 
Right 

<RadiusIn> Units will be meters. 
 
Exported only when Spiral 
Type is Arc-Spiral-Line or Arc-
Spiral-Arc 

FLOAT  

<RadiusOut> Units will be meters.  

Exported only when Spiral 
Type is Line-Spiral-Arc or Arc-
Spiral-Arc 

FLOAT  

<DegreeOfCurveIn> Units will be meters  
 
Exported only when Spiral 
Type is Arc-Spiral-Line or  
Arc-Spiral-Arc 

FLOAT  

<DegreeofCurveOut> Units will be meters Exported 
only when Spiral Type is Line-
Spiral-Arc or Arc-Spiral-Arc 

FLOAT  

<CentralAngle> Units will be decimal degrees 
FLOAT 

 

<TangentAzimuth> Units will be decimal degrees  
FLOAT 

 

<A> Units will be meters 

Exported only when Spiral 
Type is Arc-Spiral-Arc 

FLOAT 
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Field Comments Format Options 

<SpiralLength> Units will be meters 

Exported only when Spiral 
Type is Arc-Spiral-Line or 
Line-Spiral-Arc 

FLOAT 
 

<CStoSCLength> Units will be meters 

Exported only when Spiral 
Type is Arc-Spiral-Arc 

FLOAT 
 

<TStoCSLength> Units will be meters 

Exported only when Spiral 
Type is Arc-Spiral-Arc 

FLOAT 
 

<DeltaHeight> Units will be meters 
FLOAT 

 

 

3.7 Polygon 
<Polygon> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ID>PolyId</ID> 

 <FeatureCode>Poly feature code</FeatureCode> 

 <IsFeatureCodeGenerated>false</IsFeatureCodeGenerated> 

 <Perimeter>12.021</Perimeter> 

 <Area>9.053</Area> 

 <Volume>17.021</Volume> 

 <Height>2.04</Height> 

 <MemberList> 

  <Member> 

   <UID>234640932</UID> 

   <IsReversed>true<IsReversed> 

  </Member> 

  <Member> 

   <UID>234640932</UID> 

    <IsReversed>true<IsReversed> 

  </Member> 

  <Member> 

   <UID>234640932</UID> 
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   <IsReversed>true<IsReversed> 

  </Member> 

 </MemberList> 

</Polygon> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<IsFeatureCodeGenerated>  BOOL  

<Perimeter> Units are meters. FLOAT  

<Area> Units are meters squared. FLOAT  

<Volume> Units are meters cubed. FLOAT  

<Height> Units are meters. FLOAT  

<MemberList> ---SUBSECTION HEADER---   

   <Member> ---SUBSECTION HEADER---   

     <UID>  UID  

     <IsReversed>  BOOL  

3.8 Polyline 
<Polyline> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ID>PolyId</ID> 

 <FeatureCode>Poly feature code</FeatureCode> 

 <IsFeatureCodeGenerated>false</IsFeatureCodeGenerated> 

 <Length2D>12.021</Length2D> 

 <MemberList> 

  <Member> 

   <UID>234640932</UID> 

   <IsReversed>true<IsReversed> 
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  </Member> 

  <Member> 

   <UID>234640932</UID> 

   <IsReversed>true<IsReversed> 

  </Member> 

  <Member> 

   <UID>234640932</UID> 

   <IsReversed>true<IsReversed> 

  </Member> 

 </MemberList> 

</Polyline> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ID>  STRING MAXLENGTH = 32 

<FeatureCode>  STRING MAXLENGTH = 128 

<IsFeatureCodeGenerated>  BOOL  

<Length2D> Units are meters. FLOAT  

<MemberList> ---SUBSECTION HEADER---   

     <Member> ---SUBSECTION HEADER---   

     <UID>  UID  

     <IsReversed>  BOOL  

3.9 COGO Radiation 
<COGORadiation> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <IsCoordinating>true</IsCoordinating> 

 <FromPointUID>872920438</FromPointUID> 

 <ToPointUID>823898322</ToPointUID> 

 <Type> RadiationXYZ</Type> 

 <DeltaX>68.154</DeltaX> 
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 <DeltaY>100.548</DeltaY> 

 <DeltaZ>14.154</DeltaZ> 

 <Azimuth>128.2236215</Azimuth> 

 <VerticalAngle>87.22551458</VerticalAngle> 

 <Distance>60.04</Distance > 

 <Height>10.215</Height> 

</COGORadiation> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<IsCoordinating>  BOOL  

<FromPointUID>  UID  

<ToPointUID>  UID  

<Type>  STRING RadiationXYZ 

RadiationHVD 

RadiationHDZ 

<DeltaX> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

<DeltaY> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

<DeltaZ> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

<Azimuth> Included only when Type is  
RadiationHVD or RadiationHDZ. 

Units are decimal degrees. 

FLOAT  

<VerticalAngle> Included only when Type is RadiationHVD. 

Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

<Distance> Included only when Type is  
RadiationHVD or RadiationHDZ. 

Units are meters. 

FLOAT  

<Height> Included only when Type is RadiationHDZ. 

Units are meters. 

FLOAT  
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3.10 COGO Inverse 

<Inverse> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <FromPointUID>943209432</FromPointUID> 

 <ToPointUID>890230952</ToPointUID> 

 <Azimuth>60.04141548</Azimuth> 

 <VerticalAngle>45.5563215</VerticalAngle> 

 <Distance>160.04</Distance> 

</Inverse> 

 

Field Comments Format 

<UID>  UID 

<Time> See Section 1.3.1 for more information. TIMESTAMP 

<FromPointUID>  UID 

<ToPointUID>  UID 

<Azimuth> Units are decimal degrees. FLOAT 

<VerticalAngle> Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT 

<Distance> Units are meters. FLOAT 

 
3.11 Instrument 

<Instrument> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 
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  <ms>789</ms> 

 </Time> 

 <Type>RTK</Type>  

<DefinitionName>Sokkia GSR2700 IS</DefinitionName> 

 <ProfileName>Sokkia GSR2700 IS NTRIP</ProfileName> 

 <Brand>Sokkia</Brand> 

 <Model>GSR2700 IS</Model> 

 <SerialNumber>NZH0537003</SerialNumber> 

 <FirmwareVersion>3.21</FirmwareVersion> 

 <UserAppVersion>2.000</UserAppVersion>  

 <HasIntegratedAntenna>true</ HasIntegratedAntenna> 

 <RTKLinkType>GPRSCell</RTKLinkType> 

 <CorrectionFmt>RTCA</CorrectionFmt> 

 <Address>192.32.45.01</Address> 

 <PhoneNumber>192-321-451</PhoneNumber> 

 <MountPoint>CALG01</MountPoint> 

 <PortNumber>201</PortNumber> 

 <GGARate>5</GGARate> 

 <GroupRefIndexJ>2.32</GroupRefIndexJ> 

 <WaveCarrier>321.23</WaveCarrier> 

</Instrument> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<Type>  STRING RTK 

GNSS 

ETS 

MTS 

<DefinitionName>  STRING  

<ProfileName>  STRING  

<Brand>  STRING  

<Model>  STRING  

<SerialNumber>  STRING  

<FirmwareVersion>  STRING  

<UserAppVersion>  STRING  

<HasIntegratedAntenna> Included only if Type is RTK or GNSS BOOL  
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Field Comments Format Options 

<RTKLinkType> Included only if Type is RTK. STRING CellularModem 

GPRSCell 

UHFRadio 

None(Autonomous) 

<CorrectionFmt> Included only if Type is RTK and 
RTKLinkType is not None(Autonomous) 

STRING RTCA 

RTCM 

RTCMv3 

CMR 

CMR+ 

<Address> Included only if RTKLinkType is GPRSCell. STRING  

<PhoneNumber> Included only if RTKLinkType is 
CellularModem. 

STRING  

<MountPoint> Included only if RTKLinkType is GPRSCell. STRING  

<PortNumber> Included only if RTKLinkType is GPRSCell. INT  

<GGARate> Included only if RTKLinkType is GPRSCell or 
CellularModem. 

INT  

<GroupRefIndexJ> Included only if Type is ETS. 

Unit-less value. 

FLOAT  

<WaveCarrier> Included only if Type is ETS. 

Unit-less value. 

FLOAT  

3.12 Station 
<Station> 

 <UID>874653217</UID> 

 <Time>  

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <IsOrientable>true</IsOrientable> 

 <OrientationCorrection>1.23</OrientationCorrection> 

 <IsUsedInTraverse>false</IsUsedInTraverse 

 <ApplyHCollimation>false</ApplyHCollimation> 

 <HorzCollimation>0.004</HorzCollimation>  
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 <ApplyVCollimation>false</ApplyVCollimation> 

 <VertCollimation>0.002</VertCollimation>  

 <PointUID>329439253</PointUID> 

 <AssociatedInstrumentUID>745923023</AssociatedInstrumentUID> 

 <InstrumentHeight>2.04</InstrumentHeight> 

</Station> 

 

Field Comments Format 

<UID>  UID 

<Time> See Section 1.3.1 for more information. TIMESTAMP 

<IsOrientable>  BOOL 

<OrientationCorrection> Units are decimal degrees. FLOAT 

<IsUsedInTraverse>  BOOL 

<ApplyHCollimation> If the job setting is set to “Never”, the station value is overridden 
and always set to false. 

BOOL 

<HorzCollimation> Units are always arcseconds. FLOAT 

<ApplyVCollimation> If the job setting is set to “Never” the station value will be 
overridden and always set to false. 

BOOL 

<VertCollimation> Units are always arcseconds. FLOAT 

PointUID  UID 

AssociatedInstrumentUID  UID 

InstrumentHeight Units are meters. FLOAT 

3.13 Target 
<Target> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <TargetHeight>2.04</TargetHeight> 

 <PrismConstant>7.00</PrismConstant>   

 <Type>Reflectorless</Type> 

</Target> 
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Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<TargetHeight> Units are meters. FLOAT  

<PrismConstant> Always in millimeters. FLOAT  

<Type>  STRING Prism 

360Prism 

Reflectorless 

ReflectiveSheet 

3.14 ETS Observation 
<ETSObservation> 

 <UID>45646546</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>12</Hour> 

  <Min>05</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ObservationSettings> 

  <AzDirection>CW</AzDirection> 

  <IsHorizonVerticalReference>false</IsHorizonVerticalReference> 

  <IsF2>false</IsF2> 

  <ObsFormat>RawObs</ObsFormat> 

 </ObservationSettings> 

 <MeasurementType>HVD</MeasurementType> 

 <IsCoordinating>false</IsCoordinating> 

 <IsBacksight>true</IsBacksight> 

 <IsUsedInTraverse>false</IsUsedInTraverse> 

 <InstrumentObservation> 

  <HorizontalAngle>60.04</HorizontalAngle> 

  <VerticalAngle>60.04</VerticalAngle>  

  <SlopeDistance>60.04</SlopeDistance> 

 </InstrumentObservation> 

 <PrismAndAtmosCorrectedObservation> 

  <HorizontalAngle>60.04</HorizontalAngle> 

  <VerticalAngle>60.04</VerticalAngle> 

  <SlopeDistance>60.04</SlopeDistance> 
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 </PrismAndAtmosCorrectedObservation > 

 <CorrectedObservation> 

  <HorizontalAngle>60.04</HorizontalAngle> 

  <VerticalAngle>60.04</VerticalAngle> 

  <SlopeDistance>60.04</SlopeDistance> 

  <Azimuth>123.45</ Azimuth > 

  <HorizontalDistance>55.55</HorizontalDistance> 

  <VerticalDistance>55.55</ VerticalDistance > 

 </CorrectedObservation> 

 <ToPointUID>145761451</ToPointUID> 

 <FromPointUID>145761450</FromPointUID> 

 <TargetUID>913156145</TargetUID> 

 <StationUID>328416436</StationUID> 

 <HasOffset>true</HasOffset> 

 <Offset> 

  <Type>Angle<Type> 

  <HorizontalAngle>60.04</HorizontalAngle> 

  <VerticalAngle>60.04</VerticalAngle> 

  <Distance>60.04</Distance> 

  <Height>60.04</Height> 

  <UseVertAngleFromOffset>true</UseVertAngleFromOffset> 

  <POILocation>left</POILocation> 

  <DeltaX>60.04</DeltaX> 

  <DeltaY>60.04</DeltaY> 

  <DeltaZ>60.04</DeltaZ> 

 </Offset> 

</ETSObservation> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more 
information. 

TIMESTAMP  

<ObservationSettings> ---SUBSECTION HEADER---   

     <AzDirection>  STRING CW 

CCW 

     <IsHorizonVerticalReference>  BOOL  

     <IsF2>  BOOL  

     <ObsFormat>  STRING RawObs 

<MeasurementType>  STRING HV 

HVWithOffset 

HVD 

HVDWithOffset 

<IsCoordinating>  BOOL  
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Field Comments Format Options 

<IsBacksight>  BOOL  

<IsUsedInTraverse>  BOOL  

<InstrumentObservation> ---SUBSECTION HEADER--- 

This section will contain the 
observation as received from the 
instrument.  

Any corrections that have been 
applied directly on the instrument 
will not be unapplied in SDR+. 

  

     <HorizontalAngle> Units are decimal degrees. FLOAT  

     <VerticalAngle> Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

     <SlopeDistance> Included only if 
MeasurementType is HVD or 
HVDWithOffset. 

Units are meters. 

FLOAT  

<PrismAndAtmosCorrectedObservation> ---SUBSECTION HEADER--- 

This section will contain the 
observation (as received from the 
instrument) reduced for the prism 
constant and atmospheric 
corrections, if these corrections 
have been turned on in SDR+. 

  

     <HorizontalAngle> Units are decimal degrees. FLOAT  

     <VerticalAngle> Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

     <SlopeDistance> Included only if 
MeasurementType is HVD or 
HVDWithOffset. 

Units are meters. 

FLOAT  

<CorrectedObservation> ---SUBSECTION HEADER-– 

This section will contain the 
observation (as received from the 
instrument) reduced for all 
corrections turned on in SDR+: 

These may include: 

• Prism constant 

• Atmospheric correction 

• Instrument and target 
heights 

• Horizontal collimation 
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Field Comments Format Options 

• Vertical collimation 

• Curvature and refraction 

• Grid scale factor 

• Sea level correction 

     <HorizontalAngle> Units are decimal degrees FLOAT  

     <VerticalAngle> Units are decimal degrees 

Vertical reference will be zenith 

FLOAT  

     <SlopeDistance> Included only if 
MeasurementType is HVD or 
HVDWithOffset 

Units are meters 

FLOAT  

     <Azimuth> Units are decimal degree FLOAT  

     <HorizontalDistance> Included only if 
MeasurementType is HVD or 
HVDWithOffset 

Units are meters 

FLOAT  

     <VerticalDistance> Included only if 
MeasurementType is HVD or 
HVDWithOffset 

Units are meters 

FLOAT  

<ToPointUID>  UID  

<FromPointUID>  UID  

<TargetUID>  UID  

<StationUID>  UID  

<HasOffset>  BOOL  

<Offset> ---SUBSECTION HEADER--- 

Offset section included only if 
MeasurementType is 
HVWithOffset or HVDWithOffset 

  

     <Type>  STRING Angle 

SingleDistance 

RadiationXYZ 

RadiationHVD 

RadiationHDZ 

RemoteElevation 

     <HorizontalAngle> Included only when OffsetType is 
Angle, RadiationHVD or 
RadiationHDZ. 

FLOAT  
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Field Comments Format Options 

Units are decimal degrees. 

     <VerticalAngle> Included only when OffsetType is 
Angle, RadiationHVD or 
RemoteElevation. 

Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

     <Distance> Included only when OffsetType is 
SingleDistance, RadiationHVD or 
RadiationHDZ. 

Units are meters. 

FLOAT  

     <Height> Included only when OffsetType is 
SingleDistance or RadiationHDZ. 

Units are meters. 

FLOAT  

     <UseVertAngleFromOffset> Included only when OffsetType is 
Angle. 

BOOL  

     <POILocation> Included only when OffsetType is 
SingleDistance. 

STRING Left 

Right 

Front 

Back 

     <DeltaX> Included only when OffsetType is 
RadiationXYZ. 

Units are meters. 

FLOAT  

     <DeltaY> Included only when OffsetType is 
RadiationXYZ. 

Units are meters. 

FLOAT  

     <DeltaZ> Included only when OffsetType is 
RadiationXYZ. 

Units are meters. 

FLOAT  

 

3.15 Resection Station  
<ResectionStation> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 
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  <ms>789</ms> 

 </Time> 

 <IsOrientable>true</IsOrientable> 

 <OrientationCorrection>1.23</OrientationCorrection> 

 <IsUsedTraverse>false</IsUsedinTraverse> 

 <ApplyHCollimation>false</ApplyHCollimation> 

 <HorzCollimation>0.004</HorzCollimation> 

 <ApplyVCollimation>false</ApplyVCollimation> 

 <VertCollimation>0.002</VertCollimation> 

 <PointUID>329439253</PointUID> 

 <AssociatedInstrumentUID>745923023</AssociatedInstrumentUID> 

 <InstrumentHeight>2.04</InstrumentHeight> 

 <ResectionSolution>  

  <LeastSquaresStatusXY>Converged</LeastSquaresStatusXY> 

  <IterationsToConvergeXY>9<IterationsToConvergeXY> 

  <DegreesOfFreedomXY>4<DegreesOfFreedomXY> 

  <StdDevY>1.23<StdDevY> 

  <StdDevX>2.345<StdDevX> 

  <LeastSquaresStatusZ>Converged</LeastSquaresStatusZ> 

  <IterationsToConvergeZ>9<IterationsToConvergeZ> 

  <DegreesOfFreedomZ>1<DegreesOfFreedomZ> 

  <StdDevZ>0.890<StdDevZ> 

  <EnteredHeight>2.04</EnteredHeight> 

 </ResectionSolution> 

</ResectionStation> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more 
information. 

TIMESTAMP  

<IsOrientable> Indicates whether the station 
orientation correction can be 
currently computed. 

BOOL  

<IsUsedInTraverse>  BOOL  

<OrientationCorrection> Units are decimal degrees. FLOAT  

<ApplyHCollimation>  BOOL  

<HorzCollimation> Units are always arcseconds. FLOAT  

<ApplyVCollimation>  BOOL  

<VertCollimation> Units are always arcseconds. FLOAT  

<PointUID>  UID  

<AssociatedInstrumentUID>  UID  

<InstrumentHeight> Units are meters. FLOAT  

<ResectionSolution> ---SUBSECTION HEADER---   
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Field Comments Format Options 

     <LeastSquaresStatusXY>  STRING Converged 

DidNotConverge  

InsufficientObs 

InvalidInput 

MatrixNotInvertible 

NotAttempted 

NotComputableInGeographic 

UpdateError 

     
<IterationsToConvergeXY> 

Included only if 
LeastSquaresStatusXY is Converged. 

INT  

     <DegreesOfFreedomXY> Included only if 
LeastSquaresStatusXY is Converged. 

INT  

     <StdDevX> Included only if 
LeastSquaresStatusXY is Converged. 

Units are meters. 

FLOAT  

     <StdDevY> Included only if 
LeastSquaresStatusXY is Converged. 

Units are meters. 

FLOAT  

     <LeastSquaresStatusZ>  STRING Converged 

DidNotConverge  

InsufficientObs 

InvalidInput 

MatrixNotInvertible 

NotAttempted 

UserInput 

UpdateError 

     <IterationsToConvergeZ> Included only if LeastSquaresStatusZ 
is Converged. 

INT  

     <DegreesOfFreedomZ> Included only if LeastSquaresStatusZ 
is Converged. 

INT  

     <StdDevZ> Included only if LeastSquaresStatusZ 
is Converged. 

FLOAT  

     <EnteredHeight> Included only if LeastSquaresStatusZ 
is UserInput. 

Units are meters. 

FLOAT  
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3.16 Resection Observation 

<ResectionObservation> 

 <UID>45646546</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>12</Hour> 

  <Min>05</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <ObservationSettings> 

  <AzDirection>CW</AzDirection> 

  <IsHorizonVerticalReference>false</IsHorizonVerticalReference> 

  <IsF2>false</IsF2> 

  <ObsFormat>RawObs</ObsFormat> 

 </ObservationSettings> 

 <MeasurementType>HV</MeasurementType> 

 <ToPointUID>145761451</ToPointUID>  

 <TargetUID>913156145</TargetUID> 

 <ResectionUID>100663313</ResectionUID> 

 <ResectionStationUID>328416436</ResectionStationUID> 

 <HorizontalAngle>60.04</HorizontalAngle> 

 <VerticalAngle>60.04</VerticalAngle> 

 <Distance>60.04</Distance> 

 <CorrectedHorizontalAngle>60.04</CorrectedHorizontalAngle> 

 <CorrectedVerticalAngle>60.04</CorrectedVerticalAngle> 

 <CorrectedDistance>60.04</CorrectedDistance> 

 <UseHorizontalAngle>false</UseHorizontalAngle> 

 <UseVerticalAngle>true</UseVerticalAngle> 

 <UseDistance>true</UseDistance> 

 <HorizontalResidual>0.00</HorizontalResidual> 

 <VerticalResidual>1.17</VerticalResidual> 

 <HorizontalDistanceResidual>0.00</HorizontalDistanceResidual> 

 <VerticalDistanceResidual>0.14</VerticalDistanceResidual> 

</ResectionObservation> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<ObservationSettings> ---SUBSECTION HEADER---   

<AzDirection>  STRING CW 
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Field Comments Format Options 

CCW 

<IsHorizonVerticalReference>  BOOL  

<IsF2>  BOOL  

<ObsFormat>  STRING RawObs 

<MeasurementType>  STRING HVD  

HV 

<ToPointUID>  UID  

<TargetUID>  UID  

<ResectionUID>  UID  

<ResectionStationUID>  UID  

<HorizontalAngle> Units are decimal degrees. FLOAT  

<VerticalAngle> Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

<Distance> Included only if MeasurementType is HVD or 
HVDWithOffset. 

Units are meters. 

FLOAT  

<CorrectedHorizontalAngle> Units are decimal degrees. FLOAT  

<CorrectedVerticalAngle> Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

<CorrectedDistance> Included only if MeasurementType is HVD or 
HVDWithOffset. 

Units are meters. 

FLOAT  

<UseHorizontalAngle>  BOOL  

<UseVerticalAngle>   BOOL  

<UseDistance>  BOOL  

<HorizontalResidual> Units are decimal degrees. 

“NotComputable” is written if resection 
solution did not converge or was not 
attempted. 

FLOAT  

<VerticalResidual> Units are decimal degrees. 

“NotComputable” is written if resection 
solution did not converge or was not 
attempted. 

FLOAT  

<HorizontalDistanceResidual> Units are meters. 

“NotComputable” is written if resection 
solution did not converge or was not 
attempted. 

FLOAT  
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Field Comments Format Options 

<VerticalDistanceResidual> Units are meters. 

“NotComputable” is written if resection 
solution did not converge or was not 
attempted. 

FLOAT  

3.17 RTK Session 
<RTKSession> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <AssociatedInstrumentUID>434318309</AssociatedInstrumentUID> 

 <IsPositionMode>false</IsPositionMode> 

 <IsAutonomousMode>false</IsAutonomousMode> 

 <BroadcastID>INNB</BroadcastID> 

 <RTKFormat>RTCMV3</RTKFormat> 

 <BasePointUID>909853431</BasePointUID> 

 <BaseTrueAntennaHeight>2.04</BaseTrueAntennaHeight> 

 <BroadcastedBaseCoords> 

  <WGS84Latitude>51 23 15.12548</WGS84Latitude> 

  <WGS84Longitude>-114 02 48.15489</WGS84Longitude> 

  <WGS84Height>1044.681</WGS84Height> 

 </BroadcastedBaseCoords> 

</RTKSession> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<AssociatedInstrumentUID>  UID  

<IsPositionMode>  BOOL  

<IsAutonomousMode>  BOOL  

<BroadcastID> Included only if IsAutonomousMode is 
false. 

 

STRING MAXLENGTH = 4 

 Page 40 of 48 



 SDR+ XML Format Reference Guide 
  
  

Field Comments Format Options 

<RTKFormat> Included only if IsAutonomousMode is 
false. 

 

STRING RTCA 

RTCM 

RTCMv3 

CMR 

CMR+ 

<BasePointUID> Included only if IsPositionMode and 
IsAutonomousMode are false. 

UID  

<BaseTrueAntennaHeight> Included only if IsPositionMode and 
IsAutonomousMode are false.  

Units are meters. 

FLOAT  

<BroadcastedBaseCoords> ---SUBSECTION HEADER--- 

Included only if IsPositionMode and 
IsAutonomousMode are false. 

  

     <WGS84Latitude> Included only if IsPositionMode and 
IsAutonomousMode are false. 

Values are always WGS84 geographic 
coordinates (LLH). 

Units are decimal degrees. 

FLOAT  

     <WGS84Longitude> Included only if IsPositionMode and 
IsAutonomousMode are false. 

Values are always WGS84 geographic 
coordinates (LLH). 

Units are decimal degrees. 

FLOAT  

     <WGS84Height> Included only if IsPositionMode and 
IsAutonomousMode are false. 

Values are always WGS84 geographic 
coordinates (LLH). 

Units are meters. 

FLOAT  

3.18 GPS Antenna 
<GPSAntenna> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 
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 </Time> 

 <InstrumentUID>566578645</InstrumentUID> 

 <Model>SK-502</Model> 

 <Type>Vertical</Type> 

 <MeasuredHeight>2.04</MeasuredHeight> 

 <TrueHeight>89.23</TrueHeight>   

 <Model>SK-502</Model>  

 <Radius>18.0</Radius> 

 <SlantOffset>0.0</SlantOffset> 

 <VerticalOffset>0.0</VerticalOffset> 

 <PhaseCenterOffset>14.0</PhaseCenterOffset> 

 <UserOffset>0.0</UserOffset> 

</GPSAntenna> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<Type>  STRING Slant 

Vertical 

TrueVertical 

<InstrumentUID>  UID  

<Model>  STRING  

<TrueHeight> Units are meters. FLOAT  

<MeasuredHeight> Units are meters. FLOAT  

<Radius> Always in millimeters. FLOAT  

<SlantOffset> Always in millimeters. FLOAT  

<VerticalOffset> Always in millimeters. FLOAT  

<PhaseCenterOffset> Always in millimeters. FLOAT  

<UserOffset> Always in millimeters. FLOAT  

3.19 RTK Observation 
<RTKObservation> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 
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  <ms>789</ms> 

 </Time> 

 <IsCoordinating>false</IsCoordinating> 

 <IsPositionMode>false</IsPositionMode> 

 <IsAutonomousMode>false</IsAutonomousMode> 

 <RTKSessionUID>152490932</RTKSessionUID> 

 <ToPointUID>239432923</ToPointUID> 

 <AntennaUID>233213421</AntennaUID> 

 <X>432.3214</X> 

 <Y>434321.41241</Y> 

 <Z>5232.43214</Z> 

 <Duration>600</Duration> 

 <SolutionType>L1Fixed</SolutionType> 

 <StdDevX>0.01</StdDevX> 

 <StdDevY>0.01</StdDevY> 

 <StdDevZ>0.04</StdDevZ> 

 <Epochs>300</Epochs> 

 <FloatEpochs>4</FloatEpochs> 

 <PDOP>2.17</PDOP> 

 <SVCount>7</SVCount> 

 <HasOffset>true</HasOffset> 

 <Offset> 

  <Type>RadiationXYZ<Type> 

  <DeltaX>60.04</DeltaX> 

  <DeltaY>60.04</DeltaY> 

  <DeltaZ>60.04</DeltaZ> 

  <HorizontalAngle>60.04</HorizontalAngle> 

  <VerticalAngle>60.04</VerticalAngle> 

  <Distance>60.04</Distance> 

  <Height>60.04</Height> 

 </Offset> 

</RTKObservation> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<IsCoordinating>  BOOL  

<IsPositionMode>  BOOL  

<IsAutonomousMode>  BOOL  

<RTKSessionUID>  UID  

<ToPointUID>  UID  

<AntennaUID>  UID  

<X> Units are meters. FLOAT  
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Field Comments Format Options 

<Y> Units are meters. FLOAT  

<Z> Units are meters. FLOAT  

<Duration> Units are always seconds. INT  

<SolutionType>  STRING None 

L1Fixed 

L1Float 

NarrowFixed 

NarrowFloat 

WideLaneFixed 

IonoFloat 

DGPS 

Averaged 

Single 

<StdDevX> Units are meters. FLOAT  

<StdDevY> Units are meters. FLOAT  

<StdDevZ> Units are meters. FLOAT  

<Epochs>  INT  

<FloatEpochs> Included only if IsAutonomousMode is false. INT  

<PDOP> Unit-less value. FLOAT  

<SVCount>  INT  

<HasOffset>  BOOL  

<Offset> ---SUBSECTION HEADER--- 

Included if HasOffset is true. 

  

     <Type>  STRING RadiationXYZ  

RadiationHVD 

RadiationHDZ 

     <DeltaX> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

     <DeltaY> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

     <DeltaZ> Included only when Type is RadiationXYZ. 

Units are meters. 

FLOAT  

     <HorizontalAngle> Included only when Type is RadiationHVD or 
RadiationHDZ. 

Units are decimal degrees. 

FLOAT  
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Field Comments Format Options 

     <VerticalAngle> Included only when Type is RadiationHVD. 

Units are decimal degrees. 

Vertical reference is zenith. 

FLOAT  

     <Distance> Included only when Type is RadiationHVD or 
RadiationHDZ. 

Units are meters. 

FLOAT  

     <Height> Included only when Type is RadiationHDZ. 

Units are meters. 

FLOAT  

3.20 Meteorological 
<Meteorological> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <Temperature>21.000</Temperature> 

 <Pressure>760.000</Pressure> 

 <Humidity>50</Humidity> 

</Meteorological> 

 

Field Comments Format 

<UID>  UID 

<Time> See Section 1.3.1 for more information. TIMESTAMP 

<Temperature> Units are degrees Celsius. FLOAT 

<Pressure> Units are mmHg. FLOAT 

<Humidity> Units are decimal percentage (that is, 10% is 10.0). FLOAT 

3.21 Note 
<Note> 

 <UID>874653217</UID> 

 <Time> 

  <Year>2007</Year> 

  <Month>5</Month> 

 Page 45 of 48 



SDR+ XML Format Reference Guide 
 
 

  <Day>2</Day> 

  <DayOfWeek>3</DayOfWeek> 

  <Hour>10</Hour> 

  <Min>36</Min> 

  <Sec>45</Sec> 

  <ms>789</ms> 

 </Time> 

 <IsSystemNote>true</IsSystemNote> 

 <IsFeatureAttributeNote>false</IsFeatureAttributeNote> 

 <Text>LOSS OF LOCK at 11:04:23.05</Text> 

</Note> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 for more information. TIMESTAMP  

<IsSystemNote>  BOOL  

<IsFeatureAttributeNote>  BOOL  

<Text>  STRING MAXLENGTH = 4096 

 

3.22 Traverse 
<Traverse> 

  <UID>1140850689</UID> 

 <Time> 

  <Year>2008</Year> 

  <Month>7</Month> 

  <Day>28</Day> 

  <DayOfWeek>1</DayOfWeek> 

  <Hour>12</Hour> 

  <Min>49</Min> 

  <Sec>19</Sec>  

  <ms>10</ms> 

 </Time> 

 <AdjustmentMethod>CompassRule</AdjustmentMethod> 

 <AppliedInJob>true</AppliedInJob> 

 <IsClosedLoop>false</IsClosedLoop> 

 <TraverseLength>7.10138524110416</TraverseLength> 

 <TraverseSize>7</TraverseSize> 

 <AngleBalanceOption>ByDistance</AngleBalanceOption> 

 <ClosingAzimuthUserEntered>false</ClosingAzimuthUserEntered> 

 <ClosingAzimuth>1.70026414578458</ClosingAzimuth> 

 <ClosingAzimuthMisclosure>0.00423405421542</ClosingAzimuthMisclosure> 

 <HeightBalanceOption>ByDistance</HeigthBalanceOption> 

 <HeightMisclosure>0.25908216330044</HeightMisclosure> 
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 <TraverseList> 

 <StartNode> 

  <NodePoint>100663298</NodePoint> 

  <NodeStation>201326593</NodeStation> 

 </StartNode> 

 <AdjustedNode> 

  <NodePoint>100663300</NodePoint> 

  <NodeStation>201326594</NodeStation> 

 </AdjustedNode> 

 <AdjustedNode> 

  <NodePoint>100663301</NodePoint> 

  <NodeStation>201326595</NodeStation> 

 </AdjustedNode> 

 <AdjustedNode> 

  <NodePoint>100663302</NodePoint> 

  <NodeStation>201326596</NodeStation> 

 </AdjustedNode> 

 <ClosingNode> 

  <NodePoint>100663303</NodePoint> 

  <NodeStation>201326597</NodeStation>  

 </ClosingNode> 

 <ClosingAzimuthPoint>  

  <NodePoint>100663304</NodePoint> 

 </ClosingAzimuthPoint> 

 </TraverseList> 

</Traverse> 

 

Field Comments Format Options 

<UID>  UID  

<Time> See Section 1.3.1 TIMESTAMP  

<AdjustmentMethod>  STRING CompassRule 

TransitRule 

AngleBalance 

<AppliedInJob>  BOOL  

<IsClosedLoop>  BOOL  

<TraverseLength>  FLOAT  

<TraverseSize>  INT  

<AngleBalanceOption>  STRING NotApplied 

ByDistance 

Uniform 

<ClosingAzimuthUserEntered>  BOOL  

<ClosingAzimuth>  FLOAT  

<ClosingAzimuthMisclosure>  FLOAT  
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<HeightBalanceOption>  STRING NotApplied 

ByDistance 

Uniform 

<HeightMisclosure>  FLOAT  

<TraverseList> ---SUBSECTION HEADER---   

      <StartNode> ---SUBSECTION HEADER---   

            <NodePoint>  UID  

            <NodeStation>  UID  

      <AdjustedNode> ---SUBSECTION HEADER---   

            <NodePoint>  UID  

            <NodeStation>  UID  

      <ClosingNode> ---SUBSECTION HEADER---   

            <NodePoint>  UID  

            <NodeStation>  UID  

      <ClosingAzimuthPoint> ---SUBSECTION HEADER---   

            <NodePoint>  UID  
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